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Open Command (File Menu)
Use this command to add a new file to the current window.    Choosing this command will open a dialog 
box from which you can choose new a file to view.    If there is a special file viewer for the file, it will be 
shown in its native format.    Otherwise, it will be shown with either the ASCII viewer (if the file is made up 
chiefly of readable characters), or the Hex viewer.

When you open a file in this manner, the file will be displayed in the current window and its name will be 
added to the top of the "Filelist" menu.



New Window
When you click on the "New Window" button, Drag And View Gold will open up a new window with the 
same file list as the current window.    Choose this command when you want to view the same files in two 
or more windows at the same time.    You can then arrange these windows to view different parts of the 
same file side by side or choose another file from the file list and compare the two files.    You can open up 
as many new windows as you want, up to available memory on your computer.



Launch
Click on the "Launch" button to run the program associated with the file that you are currently viewing.    If 
you are viewing a data file or a picture, Drag And View Gold will query Windows to find out the name of 
the program that you have associated with the file.    If there is an associated program, Drag And View 
Gold will run that program and pass to it the file that you are currently viewing as a command line 
argument.    For example, if you are viewing a document from Microsoft Word for Windows, Drag And 
View Gold will run Word for Windows and have it load up the document that you are currently viewing.    If 
you don't have a program associated with the file will present you with a dialog box letting you know that 
and allowing you to choose a program to launch. 

If the file you are viewing is a program, Drag And View Gold will run it when you choose this command.



Select All Command (Edit Menu)
Use the Select All command to select all of the viewed file to print or copy to the clipboard.    Selected 
areas of text files, spreadsheets and databases will appear in reverse video.    Selected areas of graphics 
files will have a rectangle around them.



Copy
The Copy button will be available only if part of the view has been selected.    You can select areas to 
copy by dragging the mouse over them or by choosing Select All from the Edit menu.    Clicking on the 
Copy button will copy the selected area to the Windows Clipboard.    All text, spreadsheet and database 
files will be copied as text.    All graphic files will be copied as bitmaps.    There is also a copy menu item 
on the Edit menu



Print
Clicking on the Print button will bring up a dialog box from which you can print a file.    If part of the file is 
selected, you will be able to print just the selection or the entire file.    Spreadsheet, text and database files 
will be printed in the printers default font.    Graphic files will be printed the way they are displayed. The 
WAV file player and the Hex viewer do not allow printing.



Word Wrap (File Menu)
This command is only available in Drag And View Gold's ASCII viewer.    Use this command to turn word 
wrap on or off when viewing ASCII files.    When word wrap is on, Drag And View Gold will wrap each line 
at the current window width.    As you expand the width of the window, Drag And View Gold will expand 
the length of the lines.    When word wrap is active, there will be a check mark before this command.    
When you turn word wrap off, the check mark will disappear.



Fonts (Settings Menu)
This command will bring up a dialog box where you can choose which font you want Drag And View Gold 
viewers to use.    The font that you choose will be active in all the viewers that display text except the Hex 
viewer.



Exit (File Menu)
Use this command to close the current window.



ASCII (View Menu)
Use this command to view a file in ASCII format.



Hex (View Menu)
Use this command to view a file in Hex format.    The Hex viewer displays a file as a series of hexadecimal 
(base 16) numbers and ASCII characters.    Each line in the Hex viewer has the starting offset into the file 
of the line, 16 characters of the line as hexadecimal numbers and then the same 16 characters as ASCII 
characters.



Viewer (View Menu)
Use this command to view a file with one of Drag And View Gold's viewers that view the file in its native 
format.    This will be the default if a file format is supported by Drag And View Gold.    The only reason you 
will need to select this command is if you changed to the ASCII of Hex viewer and now want to change 
back.



Goto
This button will only be active when viewing a database or spreadsheet, or in the Hex viewer.

For database viewing, this button will open up a dialog box where you can enter a specific record to go to 
and view.

For spreadsheet viewing, this button will open up a dialog box where you can enter a specific cell to go to.

In the Hex viewer, this button will open up a dialog box where you can enter a specific hexadecimal offset 
into the file that the viewer will show.



Find
This button is active in all the viewers except the graphic and WAV viewers.    Use this button to search for 
specific text in a file.    In all viewers except the    viewer you can specify that your search be case 
sensitive.    In the Hex viewer you can search in ASCII as well as hexadecimal.

Choosing this command will open up a dialog box where you can enter your search information.    
Choosing OK will find the first match in the file.    Choosing OK each time will find each subsequent 
match.



Filelist (Main Menu)
The "Filelist" menu displays the names of all the files that have been dragged to the open window or 
opened from the file menu.    The file that is currently displayed has a check before the name.    
Highlighting another file and pressing Enter or clicking on another file name with the mouse will display 
that file.



Close All Windows (Drag And View Gold Icon System Menu)
Use this command to close all the currently open Drag And View Gold windows.    Drag And View Gold will 
still be running and its icon will still be displayed.



Close (Drag And View Gold Icon System Menu)
Use this command to exit the Drag And View Gold program.    All open Drag And View Gold windows will 
be closed at this time.



Zoom Command (Main Menu)
Use this option to quickly zoom in the view of your file up to 5X.    This command will be available with all 
files except WAV files and the Hex display.    Zooming will stay in effect only for the current file being 
viewed.    If you view another file, the Zoom will go back to 1X



Page Command (Main Menu)
This command will not be available unless you are viewing a graphic or spreadsheet with multiple pages. 
You can use it to view the additional pages of the file.    Drag And View Gold currently supports multiple 
pages in TIF, DCF\DCX, Quattro Pro for Windows (WB1), Lotus 123 for Windows (WK4) and Excel 
version 5 (XLS) files.



What is Drag And View Gold?
Drag And View Gold is a program that lets you view the contents of a file or files without having to run the 
program that created them.    Drag And View Gold can view the files created by popular word processors, 
databases, spreadsheets and bitmapped or vector graphic programs in their native format.    You can also 
view any file in plain ASCII or hexadecimal format. Drag And View Gold allows you to open multiple 
windows so you can easily compare files.    You can search for text in any file or a hexadecimal string in 
the Hex viewer.    You can also go to any cell in a spreadsheet, any record in a database and any address 
in the hexadecimal view of a file.    Drag And View Gold allows you to select all or any part of a viewed file 
and copy it to the Windows clipboard or print it.    Printing of text files will be done in the default font of the 
printer and will not necessarily be formatted the same way as the file when displayed by its parent 
program.    You can also Zoom in your view of a file up to 5 times the original file size.

You can view files with Drag And View Gold in two different ways.    You can drag the selected files from 
any file manager that supports drag and drop to the Drag And View Gold icon or to any open Drag And 
View Gold window.    Or, you can click on the "Fmlaunch" menu item that is added to Windows File 
Manager's menu bar and choose "View files".

Using the view files option will not open a new window if a window is already open.    The same is true if 
you drag files to an open Drag And View Gold window.    However, dragging files to the Drag And View 
Gold icon will always open a new window with the files displayed.

Every Drag And View Gold window maintains a listing of the files that you dragged to it in its "Filelist" 
menu.    You can use the "Filelist" menu to choose a particular file in the list to view or you can use the 
"Last" and "Next" buttons to scroll through the list of files.

Also, part of the Drag And View Gold utilities is Fileman Launcher.    Fileman Launcher installs itself as a 
file manager accessory.    Fileman Launcher will run Drag And View Gold automatically every time you run 
Windows File Manager and it will exit Drag And View Gold every time that you exit File Manager.    
Fileman Launcher will prevent the Drag And View Gold icon from being covered when you are working in 
File Manager.    And, Fileman Launcher will remember the place where you last left the DV icon and will 
place it there the next time you run File Manager.    You can add up to 9 other programs to Fileman 
Launcher and have it manage them the same way as it manages Drag And View Gold.    You can access 
Fileman Launcher from the "Fmlaunch" menu item that it adds to Windows File Manager.    To add or 
remove programs or change the way Fileman Launcher runs programs select "Modify program list" from 
the Fmlaunch menu. 

Drag And View Gold supports multiple page TIFF, DCX\DCF and spreadsheet files.    If a file has more 
than one page, there will be an active Page menu where you can choose which page to view.



Using Drag And View Gold
You can use Drag And View Gold two different ways.    You can drag files from the file manager to its icon 
or, if you're running Windows 3.1 File Manager, you can use the Fmlaunch menu that Fileman Launcher 
adds to File Manager's menu bar.

When you run Drag And View Gold it will load and show its icon at the bottom left of your screen.    If you 
want to drag files to Drag And View Gold's icon, Drag And View Gold must be running.    It will not work if 
you try to drag files to its icon in Program Manager.    If you run Drag And View Gold from Fileman 
Launcher, Fileman Launcher will keep the Drag And View Gold icon from being covered when File 
Manager is the active program.    If you are not running Drag And View Gold from Fileman Launcher and 
you want to keep its icon form being covered, you can do so by choosing "Icon always visible" from the 
Drag And View Gold settings dialog.    First click on the Drag And View Gold icon and bring up the System 
menu.    Click on the menu selection that says "Settings".    In the resulting dialog box, see that Icon 
always visible is checked.    That will cause the Drag And View Gold icon to show through anything that is 
trying to cover it.    The state of the Always Visible option will be saved when you exit Drag And View Gold 
and will become active the next time you run it. 

Fileman Launcher will remember the last position of the Drag And View Gold icon and put it there the next 
time you run File Manager.    If you choose not to run Drag And View Gold from Fileman Launcher, you 
can also have Drag And View Gold save its icon position from the settings dialog. 

To view files with Drag And View Gold, you drag files from any file manager that supports drag and drop 
to the Drag And View Gold icon and Drag And View Gold will open a window displaying those files.    The 
first file in the group that you dragged will be the one that is displayed.    All the files will be listed in the 
window's "Filelist" menu and you can use that menu to display the other files.    Additionally if you're 
running Windows' File Manager or any file manager that supports file manager extensions, you can 
choose Fmlaunch from the menu bar and then choose "View files" from the pull down menu.

If you want to view two or more files in the file listing simultaneously, you can choose the "New" button 
and Drag And View Gold will open up a new window with the same file list.    You can open up as many 
windows this way as your computer's memory will support.    You can also drag more files to any open 
Drag And View Gold window; they will be added to the "Filelist" menu and the first one in the group will be 
displayed.    The "Filelist" menu will hold up to 20 files.    After 20, as you drag new files, the older ones will 
be dropped off the list.

When Drag And View Gold displays a file, it first tries to determine if it can display the file in one of its 
special viewers.    If there is no special viewer for the file, it will be shown with either the ANSI viewer (if 
the file is made up chiefly of readable characters) or the Hex viewer.

The Drag And View Gold icon will still remain at the bottom of your screen even after you've dragged files 
to it and opened up a viewing window.    You can continue to drag files to the icon and each time that you 
do, a new window will be opened.

Any open Drag And View Gold window can be closed, maximized or minimized to an icon.    You can drag 
files to a minimized Drag And View Gold window and it will be restored and display your files. 

To exit the Drag And View Gold program, you must choose "Close" from the system menu of the Drag 
And View Gold icon.    You activate the system menu by clicking your mouse on the icon.    When Drag 
And View Gold exits, all the open windows will be closed.    You can choose to just close all the open Drag 
And View Gold windows and not exit Drag And View Gold by choosing "Close All Windows" from the Drag 
And View Gold icon system menu.

You can also run Drag And View Gold from the File/Run menu of any program manager. If you use a file 
name as a command line argument, Drag And View Gold will run and display the file that you specified in 
a window.    You can also install Drag And View Gold as the viewer for other programs such as our Zip 
manager, Drag And Zip.





Uninstalling Drag And View Gold
To uninstall Drag And View Gold run the same DVSETUP program that you did to install it.    When you 
installed Drag And View Gold it copied DVSETUP.EXE to your Drag And View Gold directory.    When you 
run DVSETUP you will be presented with two uninstall options.

Option 1. You can remove Fileman Launcher.    This option will remove the line from your WINFILE.INI 
that runs Fileman Launcher whenever you run File Manager.

Option 2. You can completely remove the Drag And View Gold installation from your computer.    Do not 
use this option to remove a previous installation of Drag And View Gold.    It can only be used to remove a 
copy of Drag And View Gold that was installed with this installation program.    Windows will not let you 
delete a program while it is running.    Therefore the DVSetup program will not be deleted during 
uninstallation.    You will have to delete DVSETUP.EXE and the Drag And View Gold directory manually.



Selecting and Copying to the Clipboard
Selecting areas of views to copy to the clipboard is very easy with Drag And View Gold.    Simply place the 
mouse pointer at the beginning of the area that you want to copy.    Then press the left button and drag 
the mouse to the end of the area that you want to copy, still holding down the left button until you are 
finished selecting.    You can also select the entire file by choosing Select All from the Edit menu.    To copy 
a selected area to the clipboard, click on the copy button or press Ctl+C or Alt+C and the selected area 
will be copied.    Text, spreadsheet or database files will be copied as text.    All graphics files will be copied 
as bitmaps.

All viewers allow selecting and copying except the WAV file player and the Hex viewer.



Settings Command (Options Menu)
Choosing this command will bring up a dialog box where you can modify Drag And View Golds settings
The settings options are:

View Highlighted File Automatically: This option will only work when you are running Drag And View Gold 
from Fileman Launcher.    If this option is turned on, Drag And View Gold will display each file as it is 
highlighted in the file manager.    It will not open a Drag And View Gold window if one is not already 
running.    For that you need the next option.

Open View Window if Necessary: This option works in conjunction with the previous one.    This will open 
a Drag And View Gold window to view files if one isnt already open.

Bring View Window To Top: This option is also    designed to work in conjunction with the option View 
Highlighted File Automatically.    When this option is checked, the view window will always come to the top 
when a new file is highlighted and consequently displayed.    If it is not checked, the view window will stay 
where it currently is.

Hide Icon: The Drag And View Gold Icon will normally be showing on the screen when it is running.    
Some users have requested that the icon be hidden and that they only use the FMLaunch menu to view 
files.    With this option you can make Drag And View Golds icon not show when it is running.    After 
checking this option you will have to quit Drag And View Gold and run it again to have it activated.

Icon Caption: Many users have requested that they be able to modify the caption of Drag And View Gold 
icon.    In this field you can fill in whatever caption you want it to have.    If you leave it blank, Windows will 
put a blank line in reverse video under the icon.



File Formats Supported by Drag And View Gold
File formats supported in this version of Drag And View Gold are:

ASCII
Hex
Microsoft Word
Microsoft Word for Windows, including version 6
Microsoft Works
Microsoft Works for Windows, including version 3
Windows Write
Word Perfect
Word Perfect for Windows, including version 6
Ami Pro
Q&A Write
dBase
FoxPro
Clipper
Paradox
Paradox for Windows
Excel, including Excel version 5
Lotus 123
Symphony
Quattro, Quattro Pro
Quattro Pro for Windows
Windows Metafile (WMF)
BMP
ICO
PCX
GIF
TIF
JPEG
DCX\DCF
ZIP
LZH
CorelDraw version 3 (CDR)
AutoCad (DXF)
Micrografix Designer (DRW)
Harvard Graphics 3 (CH3/SY3)
Encapsulated Post Script/Adobe Illustrator (EPS/AI)
Hewlett Packard Graphics Language (HPGL)
Lotus (PIC)
Computer Graphics Metafile (CGM/CTM)
WordPerfect Graphics (WPG)
True Type Font (TTF)



How To Drag And Drop
You can drag and drop files from Windows 3.1 file manager or any other file manager that mimics it.    You 
can drag and drop one file or many files.    Position the mouse cursor over a file or group of files that you 
want to drag.    Click the mouse and hold the button down and start to move the mouse.    The mouse 
cursor will change to a little white sheet of paper with a plus on it.    The cursor will turn to a circle with a 
slash through when you drag the files from the file manager window.    The cursor will remain looking like 
this until you drag the files over something that you can drop them on.    When you've dragged the files 
over something that can accept them, the cursor will revert back to a little white piece of paper with a plus 
sign on it.    Then and only then, let go of the mouse button and the files will be dropped.    If you've 
dropped the files on the Drag And View Gold Icon, a window will be created displaying the first file in the 
group of files that you dragged.



ASCII
ASCII is the name of a character set that computers store information in.    When Drag And View Gold 
views a file in ASCII format, it displays the files exactly as it appears on the disk and does not format it 
into a document, spreadsheet, database or graphic.    Text files stored in ASCII usually contain only text 
and no special characters to represent formatting or fonts.    Your WIN.INI, SYSTEM.INI, CONFIG.SYS 
and AUTOEXEC.BAT are in ASCII format.



Hex
Hex is short for hexadecimal and is a base 16 number system.    Even though computers store 
information in binary (base 2) form, binary numbers which are made up of just ones and zeros are too 
long for displaying so base 16 is a very convenient way of looking at computer memory or files.    A byte, 
the smallest unit of computer storage can be displayed by just one just 2 hexadecimal digits. 

The Drag And View Gold Hex viewer displays a file's contents as hexadecimal digits and ASCII 
characters, 16 of them on a line.    The display consists of three columns.    The first column consists of the 
offset into the file in hexadecimal.    The second column has the next 16 bytes of the file displayed as 16 
hexadecimal numbers.    And, the third column has the same 16 bytes displayed as ASCII characters.



Word Wrap
Word wrap is a feature that many word processors and viewers use to display and print text so text does 
not go off the right side of the screen or page.    Drag And View Gold will word wrap a line of text when it 
gets too long do display in the current window.    Instead of just breaking the text in the middle of a word, 
Drag And View Gold will break the text between words so the text is still readable after it is wrapped.



Last
The "Last" and "Next" buttons allow you to scroll through the files in a Window.    These buttons won't be 
active unless the Filelist menu has more that one file in it



Next
The "Last" and "Next" buttons allow you to scroll through the files in a Window.    These buttons won't be 
active unless the Filelist menu has more that one file in it.



Play
The play button will only be active when you have dragged a Wav file to Drag And View Gold.    A Wav file 
is a Windows sound file and it has a "WAV" extension.    When you drag a Wav file to Drag And View 
Gold, DV will try to play the Wav file if you have a sound driver installed.    If you want to hear the Wav file 
again, click on the Play button.
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What Is Fileman Launcher
Fileman Launcher is a utility that allows you to automatically run all your File Manager accessories along 
with File Manager. Fileman Launcher is installed when you install Drag And View Gold.    When you run 
File Manager, Drag And View Gold will also be run.    As long as File Manager is the topmost program, 
Drag And View Gold's icon will not be covered up by any other programs.    When you exit File Manager, 
all the programs that you ran with it will be exited automatically.    Fileman Launcher installs an 
"Fmlaunch" menu item in File Manager.    From the "Fmlaunch" menu you can add and delete programs to 
the programs that Fileman Launcher runs, change how the programs are run, add command line 
arguments to the programs, quit all the programs, and rerun the programs.    In addition to Drag And View 
Gold, Fileman Launcher can run up to 9 additional programs with File Manager, and quit them when you 
quit File Manager.



Using Fileman Launcher
Once Fileman Launcher is installed you don't have to do anything.    It will be run automatically every time 
you run File Manager.    There will be a menu item called "Fmlaunch" on File Manager's menu bar.    From 
the "Fmlaunch" menu you can add, delete and change the way Fileman Launcher runs programs. 



Removing Fileman Launcher
To remove Fileman Launcher, run the DVSETUP program and choose "Remove Fileman Launcher".



Adding, Deleting and Changing Program Properties
You can easily add or delete programs from Fileman Launcher or modify how it runs the programs.    Just 
choose the menu item "Modify Program List" from the Fmlaunch menu in File Manager.    A dialog box like 
this will pop up:

This dialog box shows the programs you have installed in Fileman Launcher and the ways you want to 
run them.    At the bottom of the dialog box are buttons that say "<< Last" and "Next >>";    these buttons 
allow you to scroll through the program list.    You can install up to 10 programs into Fileman Launcher.    
The upper left of the dialog box will tell you which number program you are viewing.    If you want to add a 
new program, just click on the "Next >>" button till you get to a blank entry.    Under the program heading 
enter the name of the program that you want to run with the full path.    If you are not sure where the 
program is, you can click on the browse button on the right hand side to help you find it. 

Under the program name there are three check boxes.    They say "Run with File Manager", "Visible with 
File Manager" and "Remember Icon Position".    "Run with File Manager" should be checked if you want 
the program to be run with File Manager.    "Visible with File Manager" will allow you to always find this 
program when you want to use it with File Manager.    When File Manager is on top of the other windows, 
so will be this program.    When another application has the focus, then your program will allow itself to be 
covered.    As soon as you click on File Manager and give it the focus, then your program will appear also. 
If want this option to be active, see that "Visible with File Manager" is checked.    "Remember Icon 
Position" will remember the position of the application's icon when you close File Manager and will have 
the icon appear in the same place the next time you run File Manager.    These last two options will only 
be available if you choose to have your application run as an icon.    For that you need to have the "Show 
as icon" radio button on the right hand side checked.

On the right hand side are three radio buttons that allow you to specify how you want the program to be 
run.    You can run the program as an icon.    You can run the program "Normal";    that is like running the 
program from Program Manager.    Or you can run the program "Maximized";    a maximized program will 
fill up the entire screen.    Fileman Launcher will give the appropriate command when running the 
program.    Some programs may not respond to the command and run only one way.

At the bottom of the dialog box, just above the "<< Last" and "Next >>" buttons, is an edit field called 
"Command line arguments".    If you want to add any particular command line arguments to modify how 
the program will be run, you can put them in this field.



If you want to change any entry, just go to it and type your new specifications.    Similarly, you can delete 
any entry by removing its name from the Program field. 

Clicking on the OK button will save your changes automatically.    Clicking on Cancel will discard your 
changes.

If you have made any changes to Fileman Launcher's program list, they won't become active immediately. 
You need to choose the menu item "Quit Programs" from the "Fmlaunch" menu.    That will close all the 
running Fileman Launcher programs.    Then choose "Run Programs" from the "Fmlaunch" menu.    That 
will rerun the programs according to the changes that you've made.



Run Programs
Choose this menu option from the "Fmlaunch" menu to run the programs installed in Fileman Launcher.    
This menu item will only be available if the programs aren't running.



Quit Programs
Choose this menu option from the "Fmlaunch" menu to close all the Fileman Launcher programs that are 
currently running.



Auto View
The Auto View option makes Drag And View Gold even more a part of Windows File Manager.    When 
Auto View is activated, every time you highlight a new file in File Manager, Drag And View Gold will 
display it.    This feature will work only if one file is selected in File Manager at a time.    You activate Auto 
View by clicking on "Fmlaunch" in File Manager's menu bar and then choosing "Auto view".    When Auto 
View is active, there will be a check mark in front of it.    You can turn off Auto View by selecting it again.



View Files
You can view files with Drag And View Gold in two ways.    One is by dragging them to the Drag And View 
Gold icon.    The other way is by selecting the "Fmlaunch" menu item from File Manager's menu bar and 
then clicking on "View files".    When you drag files to the DV icon, Drag And View Gold will always open 
up a new window.    When you click on "View files" Drag And View Gold will just add the files to an open 
DV window or open a windows if one is not already open.



Zip Files
Drag And Zip, a program from Canyon Software enables you to easily manage Zip files from Windows. 
With its PKZIP compatible zipping and unzipping you dont even need a copy of PKZIP or PKUNZIP and 
Drag And Zip will unzip a Zip file made with any version of PKZIP.    You just drag files from your file 
manager to the Drag And Zip icon or use the Fmlaunch menu choice, "Zip files" and you can easily Zip 
them from Windows.



Menu Title
Use this option to change the menu name that FMLaunch puts in File Managers menu bar.    Normally its 
Fmlaunch but you can change it to whatever you please.    Put and & before the character that you want 
underlined.



Configure Toolbar
Drag And File's button toolbar is very easily modified allowing you to add and delete different buttons.    
Programs can also be added to toolbar buttons.    All toolbar buttons can be configured to user Alt or Ctrl 
key combinations as hot keys.    Alt hot keys are shown in the lower right of the button as black on gray.    
Ctrl hot keys are shown as white on black.    There is also an option to completely hide the toolbar.    If the 
toolbar is hidden, the configured hot keys are still active.

To modify the toolbar:

1. Choose Customize Toolbar from the Options menu.

In the list box on the left appear the available button choices.    The top entry is SEPERATOR. 
SEPARATOR adds a space between two buttons. 

To add a new button

1 Select the position in the Toolbar buttons list box where you want the button to appear.    The new 
button will appear before the selected button.    You can also drag buttons in the Toolbar buttons 
list box to modify their position.

2. Select the button that you want to add from the Available buttons list box.    You can also choose 
SEPARATOR or NEW PROGRAM.    If a command button is already in the Toolbar buttons list 
box, it won't be in the Available buttons list.

3. Choose Add or drag the button to the right hand list box.    The button will be added.

To remove a button
1. Select the button that you want to remove from the Toolbar buttons list box.    Click on 
Remove or drag the button to the left hand list box.    The button will be removed.



Path for Fonts (Settings Menu)
In the dialog box, enter the drive and directory where Drag And View Gold DWG should look 
for fonts associated with drawings.

Drag And View Gold DWG uses three methods for finding the font files associated with a 
drawing.    First it will look in the directory of the drawing currently veing viewed.    If they cannot 
be found there, Drag And View Gold DWG will look in the directory specified in the Path for 
Fonts dialog box.    The last place looked will be in all the paths specified in the ACAD 
environment variable.



What is Shareware
Shareware is a method of marketing software where the user gets to try a fully functional version of the 
program before deciding to buy it or not.    Many of you probably have done this with non Shareware 
software because you wanted to make sure that you liked the program before you actually spent money 
on it.    With software that isn't Shareware, you are violating the software's copyright when you do that.    
With Shareware, you are expected to try out the software without first paying for it, but if you continue to 
use it after the trial period you are also violating the software's copyright.    Paying for Shareware is often 
called registering it

Drag And View Gold is available as Shareware from many bulletin boards and disk vendors.    You are 
welcome to take a copy, install it on your computer and use it.    The trial period is 30 days. 

If you like Drag And View Gold and you find that you continue to use it after the 30 day trial period, you 
are required to register it.    That way you can continue to use it and not be breaking any laws.    More 
importantly, by registering the program, you are acknowledging that you like the program and find it useful 
and you are helping Canyon Software to continue to produce programs that you will like. The registered 
version of Drag And View Gold comes with additional file viewers that cannot be distributed as 
Shareware, a printed manual and 30 day money back guarantee.    Registered users are also eligible for 
free technical support by phone, mail, fax, CompuServe or America On Line.

Additional viewers in the registered version of Drag And View Gold are:
AutoCad (DXF)
CorelDraw version 3 (CDR)
Computer Graphics Metafile (CGM)
Micrografx Designer (DRW)
Adobe Illustrator/Encapsulated Postscript (AI/EPS)
HP Graphics Language 
Word Perfect Graphics (WPG)
Lotus (PIC)
Harvard Graphics (CH3/SY3)

We also have a special version of Drag And View Gold that will view AutoCad DWG files.



REGISTRATION FORM

Orders Only 1-800-280-3691
Your registered version of Drag And View Gold will come with additional viewers for

AutoCad (DXF)
CorelDraw version 3 (CDR)
Computer Graphics Metafile (CGM)
Micrografx Designer (DRW)
Adobe Illustrator/Encapsulated Postscript (AI/EPS)
HP Graphics Language 
Word Perfect Graphics (WPG)
Lotus (PIC)
Harvard Graphics (CH3/SY3)

____ Drag And View Gold version 1.30 with Fileman Launcher, 
diskette, manual and shipping anywhere in the world @ $35 ea $________

____ Drag And View Gold DWG version 1.30 with Fileman Launcher, 
diskette, In addition to all the other viewers, this version also views, 
zooms and pans AutoCAD DWG files. @ $65 ea $________

____ Drag And View Gold with Drag And Zip
( Our Windows Zipper ) both regularly $65 @ $55 ea $________

Subtotal $________

California residents please add 7.25% sales tax: $________

Total $________

                                        Diskette size      3 1/2" [ ]      5 1/4" [ ]

All orders will be send by US mail unless requested otherwise. 

Orders Only 1-800-280-3691
Master Card ,Visa Orders and AMEX.    You may call in your registrations to Canyon Software at (415) 
415 382-7999 fax them (415) 382-7998 or send in this form with the information below.

Click here for overseas registration points.

Name As It Appears On Credit    Card 
________________________________________________________

Credit Card Number # ______________________________________________

MC [ ]    VISA [ ]    AMEX[ ]

Expiration Date ___/___

Name:__________________________________________________



Company:_______________________________________________

Address:________________________________________________

_______________________________________________________

Where did you obtain Drag And View Gold ________________________

Any comments, suggestions or bugs? 

_______________________________________________________

_______________________________________________________

________________________________________________________

Please make checks payable to:

Canyon Software
1537 Fourth Street Suite 131
 San Rafael, CA 94901

My name is Dan Baumbach I am a member of ASP., The Association of Shareware Professionals.    I can 
be reached either at the above address, on CompuServe electronic mail 71320,1277, or at (415) 382-
7999, fax (415) 382-7998.    Thank you for your registration.

The program author, Dan Baumbach, is an active member of the Association of Shareware Professionals 
(ASP).    ASP wants to make sure that the Shareware principle works for you.    If you are unable to 
resolve a Shareware-related problem with an ASP member by contacting the member directly, ASP may 
be able to help.    The ASP Ombudsman can help you resolve a dispute or problem with an ASP member, 
but does not provide technical support for members' products.    Please write to the ASP Ombudsman at 
545 Grover Road, Muskegon, MI 49442, or send a CompuServe message via CompuServe Mail to ASP 
Ombudsman 70007,3536.



Overseas Purchases

Australia
Denmark
France
Germany and Austria
Japan
United Kingdom
Holland



Australia

BudgetWare
PO BOX 496
Newtown NSW 2042
Australia
Phone (02) 519-4233
Fax (02) 516-4236

Manaccom Pty Ltd
9 Cramford Street Milton 
Queensland
Australia
Phone 617 368 2366
Fax 617 369 7589



France

Jean-Guy DUCREUX (aka Winnie)
WindowShare SARL
B.P. 2078
57051-METZ cedex 2
France
Phone 87 30 85 57
Fax 87 32 37 75



Denmark

PRO SOFT
v/ Jens Rex
Benloese Skel 4 G
DK-4100 Ringsted
Denmark



Germany

DER PD PROFI
Gerd Zöttlein
Schulstraße, 13
D-86666 Burgheim
Germany
Phone 0 8432-1296
Fax          0 8432-8674



Japan

Personal Data Factory
Shimoueki-cho 451-3
Isesaki-shi
Gunma-ken 372
Japan



United Kingdom

Nildram Software
82 Akeman Street
Tring
Herts
HP23 6AF
United Kingdom
Phone (0442) 891331 
Fax        (0442) 890303



Holland

CD & E Computerservices
Watercirkel 79
1186 LP Amstelveen, The Netherlands
tel 020-6438106
fax 020-6438106
Internet cde@xs4all.nl




